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1 Scope

This document is intended to guide you, the PI of an approved ALMA observing proposal, through the Phase 2
process of Scheduling Block (SB) generation and submission using the ALMA Observing Tool. This process has
completely changed for Cycle 4 compared to previous cycles. In previous cycles, you as the PI were responsible
only for preparing the observing proposal and Science Goals at Phase 1, prior to the proposal review process.
Based on this Phase 1 material, ALMA staff then prepared the SBs required to run the observations at the
telescope in Phase 2, the period after the proposal review process. For Cycle 4, you will generate and submit
the SBs yourself.

2 Principles

You as the PI are now responsible for generating and submitting your own Phase 2 material
before the advertised Phase 2 deadline. If the Phase 2 deadline is missed, the project may be downgraded
in priority ranking. This does not apply if an official change request (see Section 6) is pending approval.

Shortly after receiving the notification letters, PIs of approved projects will be contacted by ALMA via a
Helpdesk ticket. Any necessary communication between the PI and ALMA concerning the approved
project should proceed by replying to this Helpdesk ticket. The only exception is for official change
requests, which require an official change request ticket to be opened. The project Helpdesk ticket will be assigned
to the Contact Scientist for your project, who will be happy to assist with any queries that may arise. However,
it is in no way mandatory to reply to the Helpdesk ticket if you are able to generate the Phase 2
products to your satisfaction and submit them yourself.

3 Timeline

• beginning of August 2016: PIs are sent notification letters

• August - 15 Sept 2016: PIs prepare and submit SBs.

• 15 Sept 2016, 15 UT: Phase 2 submission deadline

• 1 Oct 2016: start of Cycle 4

4 Submitting your Phase 2 Program in Four Easy Steps!

Step 1: Retrieve your approved project from the archive
First make sure you have the latest version of the ALMA OT installed. It should say ’Cycle4PhaseII(u1)’ at

the very top of the OT pane (see Fig. 1). If you are using the Webstart version (which is strongly recommended),
the OT will automatically update before it opens up (if by any chance you still have an old OT open you need
to close it down and re-open). If you are using the tarball version, you will need to download the latest version
of the OT from the ALMA Science Portal at https://almascience.eso.org/proposing/observing-tool.

Make sure you have the very latest (u101) release of java 8 installed before opening the OT!
The previous release, u92, is affected by a bug that seriously impacts the performance of the
Webstart OT. If you cannot install the latest java version on your computer for whatever reason,
we recommend to use the tarball version of the OT instead.

https://almascience.eso.org/proposing/observing-tool


Figure 1: Opening a project from the archive

Figure 2: An accepted project will appear in the Program tab in Phase 2



Open your project from the archive using File -> Open Project -> From ALMA Archive (see Fig. 1), or by
selecting Retrieve project from the ALMA Science Archive in the pop-up window that appears when the OT is
opened. You may need to login with your ALMA Science Portal credentials to do this. You can find your project
most easily using the All my projects option1, by entering your ALMA user ID, or by entering the project code
if you have it to hand. If your project was approved, it will open up as a Phase 2 project in the Program tab
(see Fig. 2), and the Phase 1 Science Goal(s) in the ’Proposal’ tab will have been copied over into the Phase 2
observing program.

Step 2: Review and make any necessary edits to your project
Before generating the SBs, you should carefully review the information entered in the Phase 2 Science Goal(s).

This will be identical to what you submitted in Phase 1 and will usually not require any editing, unless the Phase
1 project submitted had mistakes. The most common mistakes occur for the target coordinates, proper motions
and source velocity/reference frames (in particular if the sources were resolved from SIMBAD), as well as the
spectral setup. Please check these values very carefully - it is your responsibility to make sure they
are correct! You may want to get a co-I to double-check your work; in order to do this they can simply
download the .aot file from the ALMA archive (however, they will not be able to (re-)submit the project!)

Any offset pointings that were specified in absolute coordinates in Phase 1 will have been
converted to relative offsets compared to the source coordinates in the Phase 2 Science Goal.
This conversion is performed by the OT to facilitate observations at the telescope, and should
be no cause for concern.

If necessary, you can make the following corrections to the Phase 2 Science Goal:

• you can shift the position of any pointing up to a limit of 0.5 times the primary beam size shown in the
Spatial tab in the Field Setup editor (see Fig. 3)

• you can change the central frequency on sky of any spectral window up to a limit of 20% of its bandwidth

You can make these adjustments by using the following fields in the OT (see also Fig. 3):

• Source Coordinate RA and Dec

• Source radial velocity, redshift, Doppler type

• Pointing Offset RA and Dec

• Spectral window centre frequency

Editable fields (except for those in non-selected spectral setup baseband tables) have a lilac
background, while non-editable fields have a white background.

Any changes made to these fields are cumulative, e.g. a +2′′ change in the field centre coordinate RA and
a +1′′ change in the Offset RA will result in a +3′′ overall change in pointing position. Similarly, changing the
source radial velocity by -10 km/s and shifting a spectral window central frequency by -5 km/s will result in
an overall change of -15 km/s. The limits quoted above apply to the total change in pointing position and/or
spectral window frequency with respect to the approved Phase 1 Science Goal.

1Using the All my projects option also shows you projects for which you are co-I or co-PI, however you can follow the workflow
described in this document and submit SBs only for projects where you are the PI.



Figure 3: Edits allowed in Phase 2 in the field and spectral setup editors



There is no ’reset’ button for the editable Phase 2 Science Goal fields. If you want to revert to
the original values after experimental editing, you will have to copy them over from the Phase
1 Science Goal viewable from the Proposal tab. Those values cannot be edited. Alternatively,
you can re-retrieve the last version of the project submitted from the archive.

If you need to make any changes beyond those allowed by the OT, you should seek advice from your Contact
Scientist (see Section 6). The same goes for projects with special requirements (see Section 5).

Step 3: Generate your Scheduling Blocks
Once you are satisfied that the Phase 2 Science Goals are set up correctly you can generate the corresponding

Scheduling Blocks (see Fig. 4). The quickest way to do this is by right-clicking on the Science Plan node in the
project tree and selecting Generate Phase II SBs from all the Science Goals. You can also do this for all Science
Goals individually. Alternatively, you can use the option for generating SBs available from the Tool menu item,
or the relevant icon from the toolbar.

Figure 4: How to generate SBs. If the corrections made in the Science Goal are larger than those permitted, you
will not be able to (re-) generate the SB(s)



If you made edits to any of the Phase 2 Science Goal fields that result in a pointing and/or
spectral window shift beyond the limits allowed, the OT will refuse to generate the SBs. In
order to get detailed information on which limits have been exceeded, validate the project!

If you generate the SBs and subsequently make corrections to the Phase 2 Science Goals you will be prompted
to re-generate the SBs. If you do not, the project will not validate and you will not be able to submit. You can
expand the generated SBs and view all the information contained within them, however you will not be able to
make any edits at the SB level.

Any Science Goals that were de-scoped during the proposal review process will be ignored for SB
generation, i.e. SBs will not be generated for such Science Goals. This is handled automatically
by the software, and human intervention is not necessary. De-scoped Science Goals are clearly
marked as such in the OT.

Step 4: Submit your Phase 2 Program
In order to complete the Phase 2 process you must submit the project with the generated SBs to the ALMA

archive. Select File -> Submit Project and follow the pop-up instructions. You can re-submit as many times as
necessary before the Phase 2 deadline. Note that projects with validation errors will not submit, however this
should not normally happen for approved projects, unless the corrections made were too large.

Figure 5: Submitting your Phase 2 program



It is your responsibility to ensure the Phase 2 products for your approved project are submitted
to the archive before the Phase 2 deadline. Submission of Phase 2 products by PIs will
not be possible after the deadline!

If you are satisfied with the scientific information entered in the Phase 2 Science Goals, you do
not need to explicitly check the SBs. However, if you are interested in understanding the SBs
and the information contained therein you may want to check out the ALMA SB User Guide

Before sitting back, grabbing a coffee (or tea!) and relaxing, do a final check to ensure that:

• the spectral window central frequencies, redshifts, and target coordinates, velocities, reference frames and
offsets are correct in all your Science Goals

• you have generated SBs for all your Science Goals

• you have taken the necessary action if your project requires any special considerations (see Section 5)

• you have submitted the project to the archive

Now go get that coffee!

5 Observing modes that require special consideration

• Projects containing Total Power (single dish) observations: all Total Power single dish observations
require an OFF position to be specified at Phase 2. This should correspond to a region in the sky where no
emission is expected at the frequency of observation down to the sensitivity requested. You will be asked
to provide a list of OFF positions for all sources for which Total Power observations have been requested.
It will greatly speed up the process if you pro-actively contact your Contact Scientists at your earliest
convenience (via the project Helpdesk ticket) to provide this list of OFF positions.

• Projects containing time constraints: please check the time constraints specified at Phase 1 very care-
fully, and if applicable contact your Contact Scientist to add further possible time slots or supplementary
information. Only time constraints specified in the relevant fields in the OT will be considered by default;
any additional scheduling information (including anything mentioned in the scientific or technical justifi-
cation of your proposal) needs to be brought to the attention of your Contact Scientist during the Phase
2 process.

• Science Goals that use the narrowest spectral windows offered, and/or have expected lines very close
to the spectral window edge. Due to technical restrictions on the exact placement of the spectral
windows, the desired (i.e. that specified in the Science Goal) and the actual spectral window frequency
observed may differ by up to ∼ 20 MHz. If you are hoping to observe spectral lines within a few tens of
MHz of the spectral window edge, please contact your Contact Scientist for help!

• VLBI projects: these projects follow the normal workflow. They will be assigned to a VLBI expert, and
you will be contacted if any further action is required from your side after SB submission.

• Projects that contain Solar observations: these projects follow the normal workflow, however the SBs are
submitted with the understanding that the ephemeris provided is preliminary and will be updated shortly
before the Solar campaign. If you are the PI of an accepted project containing Solar observations you will
be contacted shortly before the Solar campaign (tentatively planned for December 2016 /January 2017)
with instructions on how to provide the final ephemeris files.

• ToO (target of opportunity) projects: ToO projects follow the normal workflow, i.e. you need to generate
and submit the SBs by the Phase 2 deadline as for any other project. The triggering of SBs will then be
done via the ToO activation page accessible from the ALMA Science Portal, as in previous cycles.

http://almascience.org/documents-and-tools/cycle4/users-guide-to-alma-scheduling-blocks
https://almascience.eso.org/observing/too-activation


• Re-submissions: ALMA will check all approved Cycle 4 projects against approved (ABC rank) Cycle 3
projects (as well as carry-overs from previous cycles) and identify any SBs that are re-submissions. If the
Cycle 3 SB has already been started (if at least one Execution Block has passed QA0), the observations
from the previous cycle will be carried over to Cycle 4 and the corresponding re-submitted Cycle 4 SB
will be cancelled. If the Cycle 3 SB observations have not yet been started the Cycle 4 observations will
proceed as normal. As a PI you should normally not need to worry about this in Phase 2.

• Projects with astrometric requirements beyond those advertised in the Call for Proposals: make sure
to contact your Contact Scientist to discuss the possibility of implementing calibration strategies beyond
the standard calibration offered by ALMA.

6 Change requests

If you require any edits to the Phase 2 Science Goals that are beyond the scope of the corrections allowed, you
should first get in touch with your Contact Scientist via the project Helpdesk ticket. Your Contact Scientist will
advise you on whether or not to submit an official change request ticket to the Helpdesk. If the change request
is approved by the ALMA Directors, an ALMA staff member will make the necessary edits and create the SBs
for you. You will be informed by your Contact Scientist once the SBs are ready to be reviewed. You will need
to approve such projects via the Helpdesk before they can be added to the observing queue.

For technical reasons, once an ALMA staff member has made edits and submitted SBs for your
project, you will no longer be able to make any corrections to the Science Goals using the
ALMA OT. Instead, you will need to request them from your Contact Scientist.

If you have submitted an official change request, and you have received no feedback by the
Phase 2 deadline there is no cause for panic! Any project for which an official change request is
still pending at the time of the deadline will have the SBs generated by ALMA staff, regardless
of whether the change request is eventually approved or not. You will be contacted once this
has happened and be asked to approve the SBs via the Helpdesk.
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